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Introduction 
 

Welcome to the MCPS Unicenter Service Desk (USD). USD is an online application that can be 
used by all MCPS staff to request technology assistance.  Analysts (Help Desk, ITSS, and 
second-level supports) will use USD to open, transfer, manage, respond to, and close technology 
requests.  Analysts can also use USD and its search tools to track technology requests.  
Communications with customers can be associated with a request and documented using the 
manual email function. 



Logging In as an Analyst 
 

 NOTE: Users will only have access to USD Online from an MCPS location.  Users will 
NOT have access to USD at home. 

 
1. Go to the MCPS website:  http://www.montgomeryschoolsmd.org/ 
2. Click on Staff. 
3. In the Technology column, locate the Unicenter Service Desk link. 
4. Click on the Unicenter Service Desk link to login to the site. 
 

 
USD Login Screen 

5. Use your Outlook username and password to login. The Help Desk Tech Support 
Center home page will display. 
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USD  Home Page 

http://www.montgomeryschoolsmd.org/


Reading the Scoreboard 
There are different ways to view requests using the Scoreboard.  Analysts may view requests 
assigned to themselves, requests assigned to their group, and/or search for requests. 
 

My Requests 
The Scoreboard shows the current requests for the analyst. 
 

1. Look at the Scoreboard region on the left of your screen and locate the My Queue menu. 
 

 
Scoreboard Region 

 
2. Click on the + symbol to the left of My Queue. The menu will expand. 

 
3. Click on the My Requests link. A list of assigned tickets will display. 
 
 

 
My Queue Expanded Menu 
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Analyst’s Assigned Requests list 

 
The Headers will display the following: 

 
Column Name Description 
Request # Request Number 
Location Allows request to be tracked by specified location of problem 
Status Request is either open (active), closed (inactive), being researched, or work 

in progress. 
Open Date Date request was created 
Priority Level 4 is Normal, 3 is High, 2 is VIP, and 1 is Emergency 
Group/Parent Group is the group to which the request is assigned. If there is a parent 

request for the problem, it will be listed there 
Contact Assignee 

 NOTE: Some of the Headers are sortable. 

 
4. Click on a Request # to open and view the request. The Request Detail will display. 
 
 

 

 

 

 

 

 

 

                                                          Request Detail 
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Viewing “My Group Unassigned Requests” 
All analysts will be able to access Group Unassigned Requests in order to view requests not yet 
assigned to anyone in the group that the analyst belongs to.  For example, an ES ITSS may 
choose to view the Group Unassigned Requests at the end of the work day to check for any 
unassigned requests from end-users from their schools that have not yet been assigned by the 
Help Desk. 
 

1. Look at the Scoreboard region on the left of your screen. 
 

 
My Group Unassigned Requests link 

 
2. Click on the My Group Unassigned Requests link. The Request List for the group will 

display. 

 
       Request List for group 
 
3. Headers display the following: 
 

Column Name Description 
Request # Request Number 
Location Allows request to be tracked by specified location of problem 
Status Request is either open (active), closed (inactive), being researched, or work 

in progress. 
Open Date Date request was created 
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Priority Level 4 is Normal, 3 is High, 2 is VIP, and 1 is Emergency 
Group/Parent Group is the group it’s assigned to and Parent is if there is a parent request 

for the problem, it will be listed there. 
Contact Assignee 

 

 NOTE: The location should match the end-user’s school number or department number. 

 
4. Click on a Request # to open and view the request. The Request Detail will display. 
 

 
Request Detail 

5. Type in a request number in the top right corner next to Request to do a quick search by 
the request number and click the Go button. 

 
       

 

                                                                                             Searching by Request Number 

 NOTE: Group/Parent Header:  This is a system used by the Help Desk.  It is not 
currently used by other analysts. 

 
 

 
 
 
 
 
 
 
 
 
Request List for Analyst 
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6. The Headers will display the following: 
 

Column Name Description 
Request # Request Number 
Location Allows request to be tracked by specified location of problem 
Status Request is either open (active), closed (inactive), researching, and work in 

progress. 
Open Date Date request was created 
Priority Level 4 is Normal, 3 is High, 2 is VIP, and 1 is Emergency 
Group/Parent Group is the group it’s assigned to and Parent is if there is a parent request 

for the problem, it will be listed there. 
Contact Assignee 

 

 NOTE: The location should match the requester’s school number or department number. 

 
7. Click on a Request # to open and view the request. The Request Detail will display. 
 

 
 

Creating a New Request 
There are different ways to create New Requests.  One of the ways is to use Profile Browser, 
which is explained below. 
 

Using the Profile Browser 
The quickest and easiest way to create a new request is to use the Profile Browser.  Using the 
Profile Browser will allow you to add information much more efficiently, since many of its fields 
will automatically populate with information pulled in from the Profile Browser Contact Search. 
 

 9

Scenario:  The ITSS receives an email from a teacher requesting support to fix a TV that 
will not display the DE Streaming video in full screen.  The ITSS will create a new request 
using the Profile Browser. 



 
1. Click the View menu from the USD home page. 
 

 
View Menu 

2. Select Profile Browser.  The Profile Browser Contact Search window will display. 
 

 
Profile Browser Contact Search Window 

 
3. Click in the Last Name field and type the end user’s last name. 

 NOTE: If unsure of the spelling of the last name, type in a few letters of the last name 
and click the tab key for a list of contact names. 

 
4. Click in the First Name field and type the user’s first name. 
 
5. Click on the Search button. The Profile Browser Contact List window will display. 
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Profile Browser Contact List 



6. Click on the name of the contact. The Contact Information window will open.  
 

 
Contact Information window 

 

7. In the scratchpad region at the bottom of the window, type the issue details. 

 NOTE: Click on the Spelling button to check spelling in the Scratchpad. 

 

 
Scratchpad Region 

8. Click the New button.  
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9. The Contact Information for the end user will populate in the request. 
 

 
                                                Create New Request Page 

 NOTE:  The Affected End User, Location Description, Summary, Description Field, and 
Assignee will populate.  The fields with an asterisk are required fields.  If you are NOT the 
person assigned to resolve this request, delete your name as the Assignee under the Assignee 
field. 

 

10. Fields are described below: 
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Field Name Description 
Affected End User 
 

Will auto-fill with the end user’s name 
 

Request Area Click in the field to select 
the customer’s request area 
from the Request Area 
Selection. 
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Status Will default to Open, but can be changed by 
using the drop down menu. 

Priority Will always default to 4-Normal and can be changed by an analyst 
using the drop down menu. 

Assignee Analyst to whom the request is to be assigned. 
Group Click the Group heading to select the 

assigned analyst’s group from the list.  

Location and Location 
Description 

Will auto-fill with the customer’s school # and school name 

Call Back Date/Time Select an option if a call back is 
necessary using the drop down menu.  
 
 
 
 

Summary Will auto-fill with a few words from the Description field. 
Description Will auto-fill with what is entered in the Scratch Pad region on the 

Create a New Request screen. 
 

11. Click Save.  
 
 
 
 
 
 
 
 
 
 
 



Adding Properties to a Request 
Properties must be added when hardware replacement for printers or computers is requested. 
 

1. Open a Request. 
 

 
Open Request 

2. Click the Edit button. 
 

3. Click on the Request Area field heading.  The Request Area menu will display. 
 

 
Request Area menu 

 
4. Expand the Request area that corresponds with the end-user’s location by clicking the 

plus sign to the left of the Request Area name. 
 

 
Expanded Request Area menu 
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5. Expand the Hardware Repair link.  
 

 
Expanded Hardware Repair menu 

6. Select the hardware (computer, printer) that corresponds to the request.  The Request 
Area field will populate with this information. 

7. In the Summary Information, click the Properties tab.  The Properties tab will display. 

 
Properties Tab 

8. Fill in the 
fields in the 
Properties 
Summary 
Information 
Area. These 
fields include:  
Computer 
manufacturer, 
Computer 
model, Current 
location for 
computer, 
serial number 
and barcode. 

 
 

                                          Adding Properties in the Summary Information 
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 NOTE: Viewing Assets will help analysts who have limited information regarding the 
hardware.  For example, if the analyst is missing the barcode or serial number, viewing the 
Asset will allow the analyst to access the missing hardware information. 

Viewing a Request History for a Contact 
Viewing the Request History of the End-User will allow the analyst to gain background 
information regarding request history.  The analyst will be able to view any open, or closed 
request information as well as the assignee information. This information may help to quickly 
identify additional information that may be needed to resolve the request. 
 

1. Click the View menu from the USD home page. 
 

 
View Menu 

2. Select Profile Browser.  The Profile Browser Contact Search window will display. 
 

 
Profile Browser Contact Search Window 

 
3. Click in the Last Name field and type the end user’s last name. 

 NOTE: If unsure of the spelling of the last name, type in a few letters of the last name 
and click the tab key for a list of contact names. 
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4. Click in the First Name field and type the end-user’s first name. 
 
 
 
 



5. Click on the Search button. The Profile Browser Contact List window will display. 
 

 
Profile Browser Contact List 

6. Click on the name of the contact. The Contact Information window will open.  
 

 
Contact Information window 
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7. Click the Request History link in the Contact region on the left of the screen. The end-
user’s Request History will display. 

 

 
End-user Request History 

Viewing Notification History 
Analysts can view the Notification History of an end-user to get background information on an 
on-going request. 
 

1. From the Request History, click on the request # of the request to be opened.  The 
request information will display. 

 

 
Customer Request History 
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2. From the Request Detail page, click on View and choose Notification History.  
 

 
                                                  Request Detail 

3. The Notification History information will display. 

      Notification History for Request# 

 

Responding to and/or Updating Requests 
There are different ways to view requests using the Scoreboard.  Users may view requests 
assignment to themselves 
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Changing the Priority Level of a Request 
 

1. From the request list, right click on the request # of the request to be opened. A menu is 
displayed. 

 
 
 

 

2. Select Escalate.  The Escalate Request Window is displayed. 
 

 
Escalate Request window 

 
3. Select the priority level from the drop-down menu in the New Priority field. 
 

 
Priority Options 
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4. Click Save. 
 



Changing the Status of a Request 
 

 NOTE: The End-user will receive an auto-notification message via Outlook when the 
status of the request is updated. 

 
1. Open the Request Detail window. 
 

 
Request Detail Window 

2. Click the Activities menu on the Navigation bar. 
 

 
Activities Menu 

3. Select the activity to be updated.  The following table explains each: 
 

 21

Field Name Description 
Update Status Allows analyst to choose Close, Research, Fix in progress, or Hold a request 
Callback Analysts can use callback as a reminder to call customer back. All callbacks 

can be stored and viewed. 
Research Additional information is needed, possibly from vendor, customer, or another 

analyst. 
Transfer Allows analyst to transfer request to another analyst. 
Escalate Allows analyst to escalate request to a higher priority for resolution 
Log Comment Allows analyst to give additional information regarding request. 
Manual Notify Allows analyst to send email to customer regarding request. Allows analyst to 

send email to another analyst or second-level support or technology 



consultant.  Provides a history of all transactions attached to the request. 
 
4. Click Save after updates have been made. 

 NOTE: A shortcut to update the status of a request is to right click on the Request # from 
the Request List and choose the activity from the drop down menu. 

 

Adding and Viewing Assets 
Analysts may use Assets to view missing information for a hardware replacement, such as 
barcode or serial number. This does NOT take the place of Properties since Assets will not 
provide the Current Location or Requested Location for the hardware. 

Adding an Asset 
 

1. From the request list, right click on the request # of the request to be opened. A menu is 
displayed. 

 

2. Select Edit. The Update Request window is displayed. 

 Update Request window 

 22

3. Click the Asset field heading. 
 
 



 
4. In the Name field, type in the barcode number or the serial number of the hardware. 

 
Asset Search Window 

5. Click the Search button. 
 
6. The Asset Search list will display. 

 
7. Click the 

name of 
the asset. 

 

 

  

Asset List Window 

1. Right-click on the Asset Name in the Asset List. 
2. Choose View in the Right-click Menu. 
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3. The Asset information will display the Asset Detail field. 

 NOTE:  The analyst can view the missing information, such as the barcode, serial 
number, model or manufacturer, and add it to the Properties tab. 

 
Viewing the Asset Detail for a Ticket 

8. Click Save. 

 Update Request Window via Asset Information 

Viewing an Asset 
If the analyst needs to view hardware details they can view this information from the asset 
details. 
 

1. From the 
request list, 
right click on 
the request # 
of the request 
to be opened. 
A menu is 
displayed. 

 

 
                                           Asset details 
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2. Select Edit. The Update Request window is displayed. 

 Update Request Area 

3. Click on the Asset. 
4. The Asset information will display the Asset Detail. 

 

 
Viewing the Asset Detail for a Ticket 

Manual Notifications 
Manual Notifications are used when you want to send an email and associate it with the request.  
Examples: Correspondence with the end-user for follow-up questions, contact another analyst, or 
second level support for additional info, or contact a principal for confirmation of rights.  The 
sent message is logged in the Activities tab so there is a record of what was sent to whom. 
 

1. From the request list, right click on the request # of the request to be opened. A menu is 
displayed. 

 
 

Request List 
with right-
click menu 
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2. Select Manual Notify from the menu. The Manual Notification for Request will display. 

 
Manual Notification for Request Area 

3. Click the Add Recipient button. 
 
4. Type the name of the recipient for your manual notification. 

 
 

 
 Contact Search Area 

5. Select the recipient from the list. 

6. Click the   arrow symbol. 
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7. Click the OK button. 
 
 
 
 
 
 



8. Type the Message Title and Message Text. 
 
9. Click on the Clear Text button to delete text from the manual notification. 

 
10. Click the Notify button to send your Manual Notification. 
 

 
Manual Notification Message Example 

 

 NOTE:  The Manual Notification will be sent automatically to the recipient in Outlook, 
including a link to view the Request. 
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                                 Manual Notification via Outlook Example 



Searching for a Request 
An analyst can search for a request using a variety of search filters. 
 

1. Click the Search button on the navigation bar. 
 

 
Navigation bar 

2. Select Requests.  The Request List screen will display. 
 

 
Requests Selection 

3. Click on the Show Filter button.   
 

 
Request List 

4. The Search filter region is displayed. 
 

 
 

Search filter region 
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5. Enter the search criteria; you can enter as many criteria as you want.  
 
Field Name Description 
Assignment Status Determines if the request is assigned or unassigned to an analyst. 
Assignee Person who assigned the request 
Group Group to which the request is assigned 
Status Determines if the request is active or inactive. 
Priority 4 is Normal, 3 is High, 2 is VIP and 1 is Emergency 
Active Defines the request as closed or open. 
Request Area Category  
Configuration Item Asset 
Reported by End-User or Analyst that created the initial request 
End User Name Name of the person having difficulty 
End User ID End-User ID of the person having difficulty 
End User Location Location of the person having difficulty 
End User Organization Organization of the person having difficulty 
 

 NOTE: Activated wildcard search:  Analysts can enter a few letters without entering the 
wildcard % symbol.  When the Tab key is tapped the result will be as if the wildcard % was 
used.  An example would be kli for klingman in the End User Name field. 

 

6. Click the More button ( ) to view additional search filters.  The date filters are 
displayed. 

 
Additional search filters 

 NOTE: Users can use the data parameters when searching for closed requests, such as 
the Earliest Open Date and Latest Open Date. 
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7. Click the More button ( ) to view additional search filters.  The summary and 
description filters are displayed.   

 

 
More search filters 

 NOTE: Users can use the wildcard % search to look for requests containing specific 
words.  Users can also search by request summary to find solutions to similar issues. 

Viewing a Closed Request 
An analyst can retrieve information from previously closed requests.   
 

1. Click the Search button on the navigation bar. 
 

 
Navigation bar 

 

 
Requests Selection 

2.  Select Requests.  The Request List screen will display. 
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Request List 

3. Click on the Show Filter button.  The Search filter region is displayed. 
 

 
Search filter region 

4. Click the drop down arrow in the Active field.  A list of selections is displayed. 
 

 
 

5. Select Inactive. 
 
 
 
 
 

Active field menu 
 

 
6. Click the Search button.  The 

Request List is displayed and 
only the closed tickets are listed.  

                                Search button 

 
7. Click on a 

Request 
number to 
view the 
request 
detail.  

Request List for 
Closed Tickets 
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Personalizing Responses 
Analysts can save time by creating personalized responses for requests that require similar 
information to resolve the problem or request additional information from an end-user.  Some 
groups, such as the Help Desk will use Global Personalized Responses for certain kinds of 
requests. Global Personalized Responses will be created by the USD administrator.  The Global 
Personalized Responses will be accessible to all analysts. 
 

 NOTE: Make the name unique.  Do not use a generic name when naming the 
personalized response. For example, include initials or a number in the name. 

Creating a New Personalized Response 
 

1. Click the File menu.  A menu is displayed. 

 
File Menu Bar 

2. Select New Personalized Response.  The Create Personalized Response window will 
open. 

                           
 

 

 

 

 

 

 

Create New Personalized Response Window 
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3. Click in the Name field and type in a name. 
 

 NOTE:  Choose a name that corresponds to the response.  Remember to include initials 
or a number in the name to identify the personalized response as your own. 

 
4. Click in the Response field and type in a response. 
 

 
New Personalized Response Example 

5. Click Save. 
 

Accessing the Personalized Response or Global Personalized Response 
 

1. Open the Request Detail window. 
 

 
Request Detail Window 
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2. Click the Activities menu on the Navigation bar. 
 

 
Activities Menu 

 
3. Select Update Status.  The Status Change window is displayed. 
 

 
Status Change Window 

 
4. Click on the drop-down menu under Personalized Response and select an appropriate 

response. 
 

 

 34

                                             Personalized Response list 



 
5. Click in the User Description field.  The response will display inside the user description 

field. 

 
User Description field 

 
6. Click the drop down menu for New Status and update the status of the request. 
 

 
Status field 

 
7. Click Save. 

 
 

Closing a Request 
 

1. From the request list, 
right click on the 
request # of the 
request to be opened. 
A menu is displayed. 

 
 

 

 

 

Request List with right-click menu 
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2. Right-click on the Request # to be closed. The Right-click menu will display. 

 

 
Right-click Menu for Ticket Number 

 
3. Choose Update Status. The Status Change Request window will display. 
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4. Type in the solution to the problem 
in the User Description field. 

 
 

 
 
 
 
 
 
 

 

                                                                            Status Change to Close Request 

 
 
 
 
 
 
 
 



5. Click on the drop-down menu under New Status. 
 

 
New Status Drop Down Menu 

6. Select Closed. 
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7. Click Save. 
 



Printing Forms 
You can print a report of your requests.  This report function is available for individual request 
detail.  
 

1. Go to the window on which you want to report. 
 
2. Click File on the navigation bar. 

 
3. Select Print Form. 

 

 
File Menu 

 
4. Click Print when the Print window displays. 

 
The Request List window prints the information provided on the Unicenter summary screen 
(see below): 
 

 
                                                                 Request List Window 
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The Request Detail report provides all the details on each request in the report (see below):  
 

 
Request Detail Report 

 

Logging Out 
 

1. Click the Log Out link on the upper center area next to the Analyst’s name. 
 

 
Log Out link 
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Logging In to USD as an Employee 
 

 
 

1. Type emp: before your Outlook username. 
 
2. Type in your Outlook password. 

 

 NOTE: End-Users will only put in the username and password.  End-Users will NOT 
need to add emp: before the Outlook username. 

3. Click the Log In button. The Unicenter Service Desk home page will display. 
 

 
Employee Interface Home Page 
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4. Under the Request Support area, click on the Create a new Request link.  The Unicenter 
Service Desk home page will display. 

 

 

Creating a New Request 
1. To create a request, under the Request Support area, click on the Create a new Request 

link. 
 

 
 

2. The Request Detail window will open and the Request will have a Request number 
assigned to it. 

 

 
Request Detail Window 
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The following table describes the fields in the Request Detail window: 
 
 

Field Name Description 
Reported by Automatically populates with the ticket creator’s name. 
Phone Number Automatically populates with the ticket creator’s work phone number. To 

change the phone number, click in the field and type the correct 
information. 

Email Address Automatically populates with the ticket creator’s email address. 
Priority This field will default to 4-Normal. Employee will not be able to change 

the priority level.  Only an analyst is able to change this field. 
Request Area This is a required field. Here you will identify the work location and type 

of problem you are reporting.. See steps below. 
Request Description Allows analyst to give additional information regarding request. 
 

To change the Request Area field: 
1. Click on the Request Area button to choose the Area for the request. 
 

 NOTE: Choosing the correct Request Area will ensure that your request is sent directly 
to the group that can most quickly resolve your problem. 

2. Under Request Area, click on the  symbol to expand the menus. 
 
3. Select the areas that matches your location and type of problem. 

 

 
Request Area Selection 

4. If your request is not related to a computer/printer problem, click Other. 
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5. If your request is related to a computer or printer, click on the  symbol to expand the 
Hardware Repair link and choose the hardware that corresponds to your request. 

 
 

 
Hardware Repair Request Area Selection 



 
6. Five required fields will display under the Request Description. 
7. Fill in the Request Description field with specific details about the problem. 
8. If requesting Hardware support, you must provide the following information in the 

appropriate fields: 
• Current location 
• Computer manufacturer 
• Computer model 
• MCPS barcode 
• Serial number 

 

 
Request Detail Window 

 

 NOTE: Include your classroom number in your request description. 

9. Click on the Spelling button to check your spelling. 
10. Click the Attach Document button to upload and attach pictures or other information 

related to the problem. 
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Request Detail Window 



 
11. Click on the Save button to save your request.  This will also send your request to the 

appropriate analyst for resolution. 
 

 
 Attachment Window 

 

Viewing My Request 
1. Under Look up my existing Requests, click on the You have ( ) My Requests link. 

 

 
          Employee Interface Home Page 
 

2. The My Requests window will display. 
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3.  Click on a Request number to view the details of each request. 
 
 



 
                                         Viewing Request List for End-User 

 
4. The Request Detail will display. 

                                                 Viewing Request Detail for End-User 
 

Auto Notifications 

 NOTE: You will receive auto notifications via Outlook each time your request is 
created, updated, escalated, or closed.  You should review the auto notification, since the 
analyst often includes comments when adding information regarding your request. 

 
Auto Notify example message via Outlook 

1. Open your Outlook Inbox to view your Auto Notification messages. 
 

 
2. Click on the Notify, Auto message to view the comments regarding your request. 
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Auto Notification Message via Outlook 

3. Click on the link provided in the email message to log in to USD to view your request 
information. 
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